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Go with the Flow! Common Workflow Process in

VRED Professional software
Renu Muthoo — ASCENT - Center for Technical Knowledge

ID6079-P This class teaches the common workflow process used in VRED Professional software to
create high-quality, real-time renderings that realistically visualize design ideas. The class will begin by
opening a native VRED (.vpb) design model as a real-time rendering in the default OpenGL render
method. Students will learn to optimize the model by fixing the geometry and using Scenegraph to
organize the parts. We will assign VRED Professional software materials and we will modify them to dress
up the geometry so that the visual display is enhanced and the realism is improved. Finally, we will modify
the render setting options to obtain a high-quality rendering, and then we will create an image for
presentation. The class will finish with a brief discussion about the raytracing render method and how it
creates renderings with physically correct lighting, reflections, refractions, and shadows.

Learning Objectives
At the end of this class, you will be able to:

e Work with Scenegraph and optimize the model geometry
e Learn how to assign and modify materials

e Learn how to apply an HDR image and set it as a background environment

¢ Learn how to work with different render setting options in OpenGL rendering method and create an
image
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Renu Muthoo is an Instructional Designer with the Rand Worldwide Company, ASCENT-Center for
Technical Knowledge. Her main role is to produce a variety of documentation, which includes developing
and writing training courseware for 3ds Max Design software, Showcase software, VRED Professional
software, and various industry-specific AutoCAD software products such as AutoCAD Electrical software.
She has worked with Autodesk, Inc., products for the past 15 years, focusing mainly on design
visualization software. Using her engineering background and expertise in Autodesk products, she has
co-authored a number of books for various audiences on 3ds Max software and AutoCAD software. She
has extensive experience in creating photorealistic scenes using 3ds Max Design software, and she has
extended her knowledge into the automotive visualization/presentation field using VRED Professional
software. She is proficient in using materials and textures, illuminating scenes by providing optimum
lighting, and using renderers to create believable and high-quality visualizations.
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Autodesk VRED Professional Introduction

The Autodesk® VRED™ Professional software is a visualization, analysis, and presentation tool
for automotive and industrial designs. The high quality, real-time renderings enable you to
realistically visualize, evaluate, and review your design ideas. The completed models can be
used to produce imagery that can be used to showcase design prototypes, in presentations, or
for marketing material.

Raytraced rendered image OpenGL rendered image

The Mainville auto design is courtesy of Marc Mainville.

Workflow

The overall suggested workflow for creating an image for presentation or when using the real-
time renderer to convey your design intent is provided below:
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Open native Data . ‘ Materials ‘ Environment ‘ Visualize
.vpb file Preparation and Lighting
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* native VRED POrf,anl?e Converting Add Camera Render
file arts using Materials Views Settings
‘ Scenegraph
. OpenGL
[I)mtplmt SA?_JFUSt Creating New Add Renderings
ptions urtace Materials Environments and Creating
Normals Images
Sot Raytraced
13 . .
Transform Ambient Renderings
Add Light:
Preferences Geometry Occlusion lehts and Creating
Images

¥

Save as .vpb
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Quick Overview of the Interface

Once you open the Autodesk VRED Professional software, the screen consists of the main
rendering window, with the interface tools along the top and the bottom of the application
screen. The Autodesk VRED Professional interface is designed for intuitive and efficient access
to commands and actions.

Interface Components

The components of the interface are:

1. Menu Bar 2. lcons Bar 3. Quick Access Bar
4. Modules 5. Render Window 6. Status Bar

Input into Autodesk VRED Professional

As Autodesk VRED Professional is a visualization software and not a modeling tool, the initial
creation of the geometry is always an imported 3D CAD data. The 3D CAD data files can be
imported into the Autodesk VRED Professional software from multiple data sources, including:

AutoCAD® drawing files (DWG and .DXF), including objects created in vertical
applications, such as the AutoCAD® Architecture software.

Autodesk® Inventor® files (.IPT and .IAM).

Autodesk® Alias® files ((WIRE).

Scene files from the Autodesk® Maya® (.MA, .MB), Autodesk® Showcase® (.A3S),
Autodesk® 3ds Max®, or Autodesk® 3ds Max® Design (.3DS) applications.
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e Autodesk® Revit® or Autodesk® Simulation designs, must be exported as .FBX files
before they can be imported into the Autodesk VRED Professional software.

e Other major CAD data applications and visualization software, such as CATIA, Creo
Elements/Pro, SolidWorks, STEP, IGES, Deltagen, and Stereolithography (.STL) files.

¢ Exchange files format, such as .OBJ and .FBX.

How To: Open a Scene

1. Click ﬂ (Open) in the Icons Bar, or select File>Open.

2. Inthe Open File dialog box, locate the required folder.

3. Select afile from the list.

4. Click (=] or double-click on the file.

5. If the type of file that you selected is not a VRED native file type (i.e., .VPB, .VPE, or
.VPF), then the Import Options dialog box opens. Specify your options and click OK.

6. Save the scene as a native .vpb file.

How To: Set the Import Options

The Import Options dialog box enables you to set options so that the software can convert and
correctly process a 3D data file. The dialog box is only available for files that are not a native
Autodesk VRED file format. Suggested options to be used while importing include:

¢ Inthe Scene rollout, verify that Apply Import Options
Materials from Asset Manager is cleared.

Tesselation

HINT: By default, all imported materials are
converted into VRED plastic materials. This option is
set in FilelO tab of the Preferences dialog box. The
VRED materials display the best shader quality in
OpenGL and Raytracing render modes.

0.075

= 10.00
e Select Center in Origin, Put onto the Max Chord Length
Ground, and Adjust Object Size. /| Enable Stitching

Stitching Tolerance

TIP: If you are expecting additional parts to be
added to the model at a later stage, then leave the
Center in Origin, Put onto the Ground, and
Adjust Object Size options cleared. This will ensure
that any additional parts fit perfectly with the model,
as they are built using the original point of origin.

Which size

o For Which size fits your object best?, [
drag the slider under the appropriate picture
that indicates the relative model size.

e In the Tessellation rollout, in Tessellation
Quiality, select High for a good quality
rendering.

Import Options dialog box
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e Ensure that the first four options (Keep Surface Data, Merge Geometries, Create
Groups for Layers, Remove Empty Groups) are selected.
e Leave all other options at the default settings which are set for optimum results.

Selecting Objects

Mouse: <Shift> + click

Window: <Shift> + click (left) and drag (right) to create a window
Crossing: <Shift> + click (right) and drag (left) to create a window
Scenegraph: Select object name

Selection Display Styles

When you select an object, either or both display options,
Wireframe and Boundings (located in the Icons Bar) must
be active to display the selected objects in the Render
Window. Selection display styles

Wireframe Boundings | Headlight S

Objective: Work with Scenegraph and optimize the model geometry

Data Preparation
e Organize and optimize the parts using Scenegraph
¢ Adjust Geometry by fixing the surface normals
e Transform Geometry

Scenegraph

Access: Quick Access Bar> K (Graph); Scene>Scenegraph; Shortcut menu>Scenegraph

When you import a file from another CAD application, % Scenegraph
there might be a large number of nodes present in the sl
Scenegraph. Use the Scenegraph to sort and group the T
objects together, complete the model by cloning objects, ™ Top
and optimize the geometry. ) side

The Scenegraph lists all of the parts and geometry that
are present in the scene. The list is organized in the form
of a hierarchical tree structure and each geometric part is
called a node.

TIP: Reduce the number of levels of hierarchy and have fewer
number of overall nodes. Also, sort and group geometry
together under relevant group nodes.

TIP: Simplify the nodes to reduce the amount of data.

Scenegraph
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Scenegraph hierarchy

By default, the Root node lists the four camera views (Top, Side, Front, and Perspective) and
the Environments node. Once you open a scene or import geometry into an empty scene,

another node is added to the Root node which lists all the geometry in the scene. An icon
besides each node indicates the characteristics of the node.

Node Types

Icon

Description

D (Regular group node)

A group of objects is placed inside this node.

E (Cloned group node)

An exact copy of the parent regular group node’s
contents. If any changes are made to the group node, it
is reflected in its cloned group node as well.

i (Transform group node)

A transformation (i.e., move, rotate, or scale) has been
applied to the objects in this node.

1| (Material node)

Contains material information.

E (Animation group node)

Animation has been applied to the objects in this node.

E (Geometry node)

The polygonal geometry inside of a group node. The
geometry is the last hierarchy node of a group and is the
simplest form of node.

1B .
. (Geometry node with
Transformation)

Transformation has been applied to the geometry only.

ﬂ (Nurbs geometry node)

A nurbs geometry inside a group node. HINT: You can
reduce the amount of data to improve performance by
converting the nurbs surface into polygons.

(Environment node)

Contains information about the environment used in the
scene.

(Light Transform node)

Enables you to add transformations to light sources that
have been created in a scene.
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Scenegraph Shortcut Menu

The Scenegraph shortcut menu is used to create, edit, and modify the nodes. Right-click on a
node and select an option in the shortcut menu; the selected action is performed on all of the
subordinate nodes of the selected node.

Working in Scenegraph
Selecting and Isolating Parts

In the Scenegraph, select the object or objects and view them in the Render Window
(Boundings and/or Wireframe selected). To display individual objects separately, drag and drop
them into the Render Window, or right-click on the selected object and select Isolate View

Selected, or after selecting an object, click ﬂ (Isolate) in the Icons Bar, or press <I>.

TIP: While working in a large and complex scene with overlapping geometry, it is useful to isolate objects
so that you can work on them separately.

Reorder Nodes and Objects

After importing a file from another CAD application, there might be a large number of nodes
haphazardly present in the Scenegraph. For easily locating the parts, organize and group the
nodes in a logical manner. Click and drag nodes to a new location as well as move subordinate
geometry from one node to another by dragging and dropping it into another node.

Group Objects
Grouping enables multiple objects to be treated as a single unit, but still retain the ability to
control each object separately. In the Scenegraph, right-click on the node and select
Create>Group (<Ctrl>+<G>). Rename the new group
logically and drag and drop the nodes.

Optimize Module

Access: Right-click node>Edit>Show Optimize Module;
Scene>0Optimize; Shortcut menu>Optimize

Face Normals)

Optimizing the model enhances the render capabilities and
speeds up the rendering process. Using the default settings
does not make any significant difference to the Scenegraph,
but improves back end calculations and rendering speed.
Some of the options include:

e Cleanup Group Nodes — Removes empty nodes.
e Merge Geometry Nodes — Consolidates the extra

nodes.
e Flush Transformation Nodes- Converts

Transformation group nodes to regular group nodes. Defat Optimize
e Flush Material Group Nodes — Converts Material

group nodes to regular group nodes. Optimize Module
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Adjust Geometry

After importing the objects into the scene, there might be some discrepancies in the geometry
that need to be fixed before you modify or manipulate the design for presentation. For the
geometry to render properly, the surface normals should always be facing towards the camera.
If the normals are reversed, shadowing effects are created and the rendering is flawed.

Checking geometry
Access: Visualization>Vertex/Face Normal Rendering; <F5>
To visually inspect the orientation of the normals, change to the Vertex/Face Normal mode

where the geometry is displayed in different colors. Each color indicates a specific orientation of
the face and vertex normals. The colors indicate:

Violet

e Green: Face and vertex normals facing correctly.

Gold
All the geometry should be green.
e Blue: Normals reversed for both faces and
vertices. Green
e Gold: Face normals reversed, vertex normals
correct. Blae
e Violet: Face normal correct but vertex normals reversed. Vertex/Face Normal Mode

Fixing Geometry

Access: Scene>Geometry Editor; Shortcut
menu>Geometry Editor Normal Calculations

Crease Angle 35.0C Calculate Normals

To correct the orientation of the surface normal, use
the options in the Normals tab>Normal Calculations -
rollout>Flip Normals area of the Geometry Editor gt
Module. The options are: Fip Normals

o LTS - Repairs blue surfaces
o Face/Surface - Repairs gold surfaces

Vertex - Repairs violet surfaces
o Ifa few surfaces of a selected part require to
be repaired, hold <Alt> and right-click on the
individual surface. Geometry Editor>Flip Normals

Mirrored Flip Normals

Adjacency Selection

Seperate Objects

Tangents [ Binormal

How to: Prepare the Data

1. Open the Scenegraph module.
2. Investigate the hierarchy of the nodes and also investigate the

listed node types by expanding the nodes using +/- and the : i
slider bar. =St

3. Using the Scenegraph, sort and group the objects together. - l_a :::E;z::
Right-click on a node and select Create>Group, rename the =55 Rl o ee
newly created Group node, and drag and drop the required -
geometry nodes into the new group node. Create/Rename Group node

8
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4. Logically consolidate the geometry nodes under a single group node. Remove any
empty group node using the Optimize module (Cleanup Group Nodes).

%[> sHELL rail_surf#3343

Original hierarchy Consolidating by drag and drop ~ Optimize (Cleanup Group Node)

5. Reduce the complexity of the models by changing && (Nurbs Geometry) and
n (Material) nodes to simple = (Geometry) nodes.
a. Set Flush Material Group Nodes option in the Optimize module to simplify
n (Material) node.
b. Right-click on the group node containing &d (Nurbs Geometry) and select
Edit>Surfaces>Convert to Mesh to simplify it.

P> sHEL_rai_surf#3101

Nurbs geometry nodes converted to simple geometry nodes

6. After simplifying nodes, sort, consolidate, and optimize the nodes again.

7. Visually check the normals by selecting Visualization>Vertex/Face Normal Rendering,
or press <F5> to enter the Vertex/Face Normal rendering mode.

8. Inthe Render Window, select the geometry that is not green in color.

9. Depending on the color, click on the appropriate button in the in the Flip Normals area of
Geometry Editor Module to make them green (correct orientation). If a portion of a single
object needs correction, use the <Alt> + right-click option.

10. Select Visualization>Realistic Rendering, or press <F3> to return to the Realistic
Rendering mode.
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Objective: Learn how to assign and modify materials

Material Editor

Access: Quick Access Bar>@(MateriaIs); Scene>Material Editor; Shortcut menu>Materials

The Material Editor is an interface for listing, creating, converting, modifying, and assigning
materials. It enables you to create a new material by modifying the attributes of an Autodesk
VRED Truelight material. There are 17 pre-defined Truelight materials available in the software.
These are designed specifically for automobile visualization. Each material contains attributes
that are specific to the selected material for detail enhancement. Each material can be modified
by adjusting its attributes. The Material Editor also enables you to convert the imported
materials to VRED Truelight materials and modify them as required.

Groups, Tags (Lists materials) Attributes

Preview

Toolbar

Material Editor Sections

Groups, Tags Section

The Groups, Tags section contains a list of all the materials that are present in the scene. Right-
click anywhere in this section to open the materials shortcut menu which provides you with the
following options:

o Create Material: Contains a list of Truelight materials that can be customized, as
needed.

-
0 EXT_pla
EX

0 EXT_tire

O b -

O INT_gla: e Phong
& T e Jastic
& T et

&) np

2

& 7ol

o oo

Libraries

Create Material Convert>To Truelight Material

10
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e Convert>To Truelight Material: Converts the imported materials to Truelight material.
e Create Environment: Creates a new environment, skylight, or an environment switch.

Attributes Section —
The attributes for a material are grouped in rollouts. \? ) @ (e
The first few rollouts provides attributes that are specific ( A\

to the Truelight material that was used as a base
material (Chrome material), while others are common to
all of the Truelight materials.

o

Chrome Material

¢ Incandescence: Sets properties like color and R ——
intensity for self-illumination. e T

e Transparency: Sets transparency. For
complete transparency use See Through option.

o Displacement: Sets the height information for
2D images.

e Raytracing: Options for raytracing.

e Common: Options for Occlusion color, intensity,
and lighting mode. Material Attributes

Incandescence
Transparency
Displacement

Raytracing

In addition to the common attributes, each material has its own specific attributes. Some of the
specific attributes are as follows:

¢ Texture Channels: Depending on the material, texture channels might be available.
Sets texture maps in four channels (Diffuse, Glossy, Roughness, and Bump).

Diffuse Texture Load
Use Texture /' | C:/VRED/Criginal Dataset/mages/leather.png = - (-' TI
Delete
Reload
Save

Diffuse Texture Attributes

e Use Structure: For some materials (Brushed Metal, Plastic), the Use Structure options
(generally in the Bump Texture rollout) can be used to create an inbuilt texture and bump
effect. It provides you with options to set the direction and the depth of the metal grain.

=N V/,_f/i

Planar XY Radial XY Radial YZ
Higher SizelU LowerSizel! Hinher Size L

TIP: You can achieve high-quality renderings using the Truelight materials as they have the capability of
generating accurate lighting effects.

11
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Some VRED Truelight Materials

e Chrome: Reflective metallic surfaces.

e Brushed Metal: Less reflective metal surfaces (wheel rims).

e Glass: Transparent or frosted glass material.

¢ Metallic Carpaint: Highly reflective metallic painted surfaces (car bodies).

¢ Flipflop Carpaint: Color variation based on the viewing angle.

o Triplanar: Surfaces with texture mapping (leather or fabric surfaces: car seats).

e Tire: Textures for treads and sidings.

Glass Material

Chrome Material

stom Medium
]

1,00
0.04
Saturation 1.00
Type | Hig
'

Roughness

Glass Material

Brushed Metal Material

Clearcoat Flake Int

Brush Orientation Clearcoat

Brush g | Triplanar -
0.15
10.00

Triplanar Mapping
0.00

Metallic Carpaint Material

Texture Settings

Diffuse Texture

Tire Material

12
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How to: Convert Material

Open the Material Editor.

In the Groups, Tags section, select a material which needs to be converted. (By default,
while importing models, the materials are converted to plastic material)

In the Render Window, identify the parts that have the selected material and determine
the material that is appropriate for the parts.

Rename the material to be converted. Right-click on the material and select Convert>To
Truelight material>new material.

In the Attributes section, modify the settings as per your requirements.

Plastic Material with the name Teak Renamed to INT_leather_yellow and converted to Triplanar

How to: Create and Assign Material

1.
2.

Open the Material Editor.
In the Groups, Tags section, right-click anywhere and select Create Material>new
material. Rename the new material, as needed.

Select the parts that require the new material. In the Material Editor, in the Groups, Tags
section, right-click on the new material and Diffuse Texture

click Apply to Selected Nodes. UseMarkings &7 [ 57ive_ Saewat.pa | (oo™ ¥

In the Attributes section, modify the settings fle
as per your requirements.

T Vi,
$2% Materials

Texture Settings

V]
V]
V]
V]
V]
V]
V]
V)
&
0.
&
V]
(V]
V]
(V]
O =
(V]
g.
¥

New material EXT _tire_back using the Tire Truelight as its base material; using textures for Markings and Profile

13
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Assign Materials

After materials have been created, you need to assign them to the geometry so that they are
visible in the Render Window. Methods of assigning materials to the geometry:

¢ Dragging from the Material Editor and dropping in the Render Window.
e Dragging from the Material Editor and dropping in the Scenegraph.
e Copying and pasting material. <M>+click to copy and <M>+right-click to paste.

e Using the Material Editor (Shortcut menu>Apply to Selected Nodes; Toolbar>).

+ 3¢ [ obj_09

- % I— ¥ Armstand
x P obj_ 10
x > obj 05
% [ obj 06

=
+ % A obj_11

+ % HB obj_12

Drag/drop in the Render Window

Copy and Paste material Using Material Editor

Ambient Occlusion

¢ The Autodesk VRED Professional software uses Ambient Occlusion (AO) to simulate
shadows. AO uses shaders to calculate the extent to which an area is inhibited by
incoming light, thus enhancing the detail in dark crevices, cracks, and along edges.

e AO is NOT physically accurate and is not based on any physically accurate light. It
imitates the effects of light and approximates shadows.

e AO is created separately and its calculations are used to define the shadows with the
OpenGL rendering mode, as well as some options in the Raytracing rendering mode.

TIP: For high quality rendering, the result with AO should be smooth and is dependent on the level of
detail of the selected geometry. The higher the density of the wire mesh of the geometry, the better the
quality of shadow using AO.

14
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Checking AO

Access: Visualization>Ambient Occlusion Rendering;

<F7>

To visually examine if the shadows have been calculated
using AO or if the calculated shadows are smooth, change
to the Ambient Occlusion visualization mode. In this
mode, the geometry is displayed without any materials,

making it easier to examine the quality of the shadows. Indirect Humination

»’| Enable

Calculating AO Qualty  Medki Gty

Access: Scene>Ambient Occlusion; Shortcut
menu>Ambient Occlusion

To calculate the shadows or to improve the quality of

already calculated shadows, use the options in the i

Ambient Occlusion module. The sections include:

Direct lllumination: Sets the shadow quality. The
higher the quality, more samples are created.

Indirect lllumination: Sets indirect illumination. Caladote Al Calafate Mssing
Subdivision: Sets the quality of Subdivisions. To :
improve the quality, increase the subdivisions. Ambient Occlusion Module

How to: Calculate Ambient Occlusion

S

Select the geometry for which you need to calculate Ambient Occlusion.

Open the Ambient Occlusion module (Scene>Ambient Occlusion).

In the Direct lllumination rollout, select the Shadow Quality as required.

In the Indirect lllumination rollout, select Enable, and then select the Quality required.
ClICk Calculate Al .

To examine the AO in the Render Window, change to the Ambient Occlusion rendering
mode. (Visualization>Ambient Occlusion Rendering; <F7>).

* The results in the Ambient Occlusion rendering mode display without the materials
and should be smooth without any blotchiness.

Return to the OpenGL rendering mode (Visualization>Realistic Rendering; <F3>).

.S |

AO calculated with problem areas Applied Subdivision and problem areas fixed

15
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Objective: Learn how to apply an HDR image and set it as a
background environment

Environments

Access: Quick Access Bar> (Materials); Scene>Material Editor; Shortcut menu>Materials

The Autodesk VRED Professional software uses a default environment (named Studio) for all
new scenes. The environment consists of a background image, along with its associated
lighting, shadows, highlights, and reflections. The environment acts to enhance the visual
display of a model and improve realism. The background of an environment is a High Dynamic
Range (HDR) image. To add, remove, or modify the environment use the Material Editor. Select
the environment in the Material section to display its attributes and modify as required. The
rollouts include:

Environment Material: Enables you to load, save, and reload the HDR image. You can
use the Is Visible option to remove the HDR image and use a simple background color.

HINT: If Is Visible is cleared and the background color is used, the lighting from the HDR image
is still used although the image is not visible.

HDR Light Studio: Enables you to load and save the current HDR Light Studio Project.
A separate HDR Light Studio plugin is required for additional options.

Color Correction: Enables you to work with values for exposure levels, hue color,
contrast/brightness and other color related options.

Transformation: Enables you to reposition the HDR image.

Raytracing Settings: (Available in Raytrace rendering mode.) Enables you to set the
illumination modes for still frame and interactive raytrace renderings.

Environment Material

Environment |ata\Internal\defaultEnvironment.hdr | || gl . C"

Environment

HDR Light Studio
Color Correction

1.00

Warm | 504K | %

Material Editor> Environment Attributes

16
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How to: Create a new environment with a new HDR image

1. Open the Material Editor.

2. Right-click anywhere in the Groups, Tags section and select Create
Environment>Sphere Environment.

3. Inthe Load Environment Image dialog box, open the hdr image.

4. Inthe Groups, Tags section, the new material node is created with the B icon indicating
that it is an environment. Select the new environment to display its attributes.

Initial position of the environment Environment repositioned to display the buildings as backdrop

TIP: Every new environment uses a unigue shadow plane. Shadows of the geometry with the ground
must be calculated for each environment used.

How to: Calculate the Ambient Occlusion for the new shadow plane

1. Inthe Ambient Occlusion rendering mode (Visualization>Ambient Occlusion;<F7>),
visually check that there are no shadows with the new environment.

2. Open the Scenegraph and expand the EnvironmentsTransform>Environments.
Expand both the Studio and the newly created environment.

3. Open the Ambient Occlusion module.

In the Scenegraph, select Studio>ShadowPlane.

5. Inthe Ambient Occlusion module, select Settings>Load from Node. This automatically
loads the settings of the selected shadow plane which is the Studio Shadow Plane.

E

Jomel
x D‘ ShadowPlane1

Loading Studio Shadow Plane Settings

17
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In the Scenegraph, select the new shadow plane geometry. In the Ambient Occlusion
module, click Calculate All.

In the Ambient Occlusion rendering mode notice the shadows of the geometry with the
plane.

No AO for the new shadow plane AQ calculated for the new shadow plane

Select shadow plane in the Scenegraph and in the Material Editor, right-click, Create
material>Shadow. The new shadow plane material is created in the Material Editor.
Modify the shadow plane material settings.

* g e @Enel HacK
M) B e Hacs Shadow Material

cksl

Reflection

Raytracing

Shadow Plane Attributes

18
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Objective: Learn how to work with render setting options in
OpenGL rendering method and create an image

Rendering

By default, the view that is displayed in the Render Window is interactively being rendered using
the OpenGL render mode. Two rendering methods are available in the software: OpenGL
rendering and Raytracing.
e OpenGL render method- Uses the GPU (Graphics Processing Unit) to render
calculations, resulting in a fast response time rendering.

Access (if Raytracing is on): Icons Bar> clear (Raytracing); clear
Visualization>Toggle Raytracing; <F3>

e Raytracing- Uses the CPU (Central Processing Unit) and can be used to calculate
physically correct lighting, reflections, refractions, and shadows. It can affect the speed
and performance of the software.
Access: Icons Bar> (Raytracing); Visualization>Toggle Raytracing; <F4>

¢ The rendering mode that is currently used is indicated in
the Status Bar as RR-GL: OpenGL or RR-RT: Raytracing.

981.4MB RR-GL 1245,1MB RR-RT

Status Bar-Render Modes
Render Settings

Access: Quick Access Bar> M (Render); Rendering>Render Settings; Shortcut
menu>Render Settings

Before you save a rendered image, review and adjust the
render settings for the scene using the Render Settings SRR R
module. The various tabs are: S

File Output tab

Commonly used options:

e View: Sets the Camera view for rendering.

e Filename: Sets the location for saving the rendering.

¢ Image Size Presets: Sets the size for the rendered
image.

e Printing Size: Sets the size for printing the image.

¢ Resolution: Image resolution (pixels per inch).

o Region Render: (Available with Raytracing.) Sets
the region for rendering.

HINT: Using the cursor to define the region, click l!l
(Region) in the Icons Bar, press <R>, and then use the
nder

cursor to create a window. Click go to activate
the selected area. Render Settings>File Output

Add to Render Queue

19
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Render Mode: Sets the lllumination modes for still frame rendering. The modes are
CPU Rasterization, Precomputed Illlumination, Precomputed + Shadow,
Precomputed + IBL, and Full Global lllumination.

Render Quality: Sets the render quality (i.e., Draft-32 image samples. Preview-128.
Production: 512, Production Interieur-2048, Custom- any user defined number).

General Settings tab

The options in this tab are used to adjust the quality of the image by smoothing the edges
(antialiasing). The options are used to adjust the quality of image while antialiasing.

Antialiasing

Access: Icons Bar> E (Antialias); <SpaceBar>

Antialiasing is the process of smoothing edges and removing jagged diagonal lines that display
in the Render Window. This process improves the display quality of a scene substantially.

Without Antiakasing With Antaliasing

If Antialiasing is activated, the smoothing of edges starts as soon as you stop navigating
(release the mouse button) in the Render Window. The start of antialiasing is indicated
by the percentage calculation wheel attached to the cursor. If you click in the model, the
antialiasing is aborted and restarts as soon as you release the mouse button.

The percentage of antialiasing that is completed, along with the render time remaining, is
displayed in the Status Bar and is also attached to the cursor.

. '.
1200.0 MB RR-GI{AA: 7.031% QPU Usage: 17.217% Rende eleft: 21s k.‘gs:

Status Bar- Antialiasing percent Cursor- Antialiasing percent

Raytracing Quality tab
This tab provides you with options to set the raytracing settings.

How to: Create a Rendered Image in OpenGL

1.
2.

Set the orientation of the scene for creating an image.

Review the scene and check if the edges of the geometry are all smooth. To improve the
visual display, activate antialiasing.

Once the antialiasing is complete, without clicking anywhere, review the scene and
ensure the edges have been smoothed.

Open the Render Settings module.

Set the size for the image using Image Size Presets. (File Output tab>Image rollout)
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6. Set the Render Quality to Production for the final image. Otherwise use a lower quality
if you are at the checking stage.

HINT: The selected option in the Render Quality is reflected in the General Settings
tab>Image Samples as Render Quality and Image Samples are interdependent. For
example, if you select Draft as Render Quality, the Image Samples are automatically set
as 32 and vice versa. Similarly, changing the Render Quality to Preview sets the Image
Samples as 128 and so on.

Render Mode | Full Global Tllumination

Render Quality | Draft

-

16.00 | ¥

Adapdive Sampling: High Quality

8. Ensure that the rendering looks as required and then click [ R ]
9. Inthe Save Rendering dialog box, save the image as a .png file.
10. Open the rendered image to review it.

Rendered Image using OpenGL
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Additional Information

[llumination modes in Raytracing

In the Render Settings Module, the Raytracing Quality tab provides you with options to set the

raytracing settings.

The lllumination Mode rollout provides you with different types of illumination options that can be
used when rendering with Raytracing. These illumination modes can be set for both Interactive
or Still Frame rendering.

CPU
Rasterization

Tllumination Mode

Interactive | Precomputed + Shadow | ™
CPU Rasterization
Precomputed Hlumination
Precomputed + Shadows
Precomputed + IBL

Full Global Tlurmination

Still Frame

Photon Tracing

Illumination modes

Works similar to the OpenGL mode, but the computation processes are
handled by the CPU. This illumination mode can be used for huge
datasets, or when your graphic card performance is not sufficient for the
kind of scene you want to render. It does not compute direct reflection or
refraction, and therefore is not used for photorealistic visualizations.

Precomputed | ges the Ambient Occlusion (AO) shadows that are baked on the

lllumination geometry, along with precomputed indirect illumination. It only calculates
the reflections, refractions, and correct shadows from the light sources
that are present in the scene.

Precomputed | ges the precomputed Image Based Lighting (IBL) and indirect

+ Shadows illumination. This mode does not use the precalculated AO, but calculates
the shadows from the currently active scene environment.

Precomputed | ses the precomputed illumination, but calculates the IBL. In addition, this

+IBL mode calculates and generates glossy reflections.

Full Global Global lllumination (GlI) algorithms describes how the interaction of the

lllumination

light is physically correct with multiple surfaces. As the name specifies,
Full Global lllumination computes complete illumination in the scene, and
thus produces high quality realistic images.
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Downscale

During Raytracing, the rendering calculations are performed by the CPU. To ensure efficient
navigation in the Render Window, the display quality should be reduced using Downscale.

Access: Icons Bar> u (Downscale);
e Levels of downscale - Low, Medium, or High.

w
Downscale
Off
w" Low
Medium
High

Downscale levls Low Downscale High Downscale

HINT: Downscale is available while using Raytracing render mode because the performance is
significantly dependent on the number of pixels to be rendered. In OpenGL, reducing the number of pixels
has virtually no effect on performance.

How to: Create a Rendered Image of a Region in Raytracing

1. Open the Render Settings Module. In the Raytracing tab, set both Interactive and Still
Frame to Precomputed lllumination.

2. Inthe Icons Bar, click (Raytracing). Wait till the Raytracing calculations are
complete.

3. Orbit around and ensure that the scene is at the final stage of display and no changes
are required.

4. Inthe Render Settings module, in the Raytracing Quality tab, in the Illumination Mode
rollout, set Interactive to Full Global Illumination.

5. Orbit around the Render Window and notice how hard it is to navigate. Select
Downscale and use different levels of downscale till you can navigate around efficiently.

6. Set the point of view of the scene for creating an image.

Set the size for the image using Image Size presets. (File Output tab>Image rollout)

8. Set the Render Quality to Production for the final image.

~
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9. Enable Render Region by selecting it.

10. Toggle off Downscale.

11. In the Icons Bar, click I (Region). Press <R>, and then using your cursor, click and
drag to define the upper left and lower right corners to create a window.

Creating Region Window

12. In the Render Settings module, in the File Output tab, click o1 to activate
it. The coordinates in the Upper Left Corner and the Lower nght Corner are
automatically calculated as per the created window.

13. Render the image for the region and save.

14. Open the image to review it. Notice the physically accurate reflections created near the
front and along the bottom of the grill.

Raytraced image OpenGL image
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Conclusion

The Autodesk VRED Professional software enables you to create high-quality realistic images
for presentation, or use the real-time renderer (either OpenGL or Raytracing) to convey your
design intent. As the software renders in real-time, it enables you to realistically visualize,
evaluate, review, and then successfully present your design ideas.

OpenGL: As the scene is being rendered interactively in real-time, in the default OpenGL
renderer, it is easier to navigate in the scene, transform the geometry, modify materials or
cameras, and then output images. The renderings created in this render mode are near
photorealistic and are calculated quickly, thus making it easier to work with.

Raytracing: Raytracing is used to calculate physically correct lighting, reflections, refractions,
and shadows. Depending on the illumination mode you are using, you can add realistic
shadows and reflections to the scene to produce very high-quality, photorealistic visualizations.

Raytraced rendered image OpenGL rendered image

25



	Learning Objectives
	About the Speaker
	Autodesk VRED Professional Introduction
	Workflow
	Quick Overview of the Interface
	Input into Autodesk VRED Professional
	How To: Open a Scene
	How To: Set the Import Options
	Selecting Objects
	Selection Display Styles


	Objective: Work with Scenegraph and optimize the model geometry
	Data Preparation
	Scenegraph
	Scenegraph hierarchy
	Node Types

	Scenegraph Shortcut Menu
	Working in Scenegraph
	Selecting and Isolating Parts
	Reorder Nodes and Objects
	Group Objects
	Optimize Module


	Adjust Geometry
	Checking geometry
	Fixing Geometry

	How to: Prepare the Data

	Objective: Learn how to assign and modify materials
	Material Editor
	Groups, Tags Section
	Attributes Section

	Some VRED Truelight Materials
	How to: Convert Material
	How to: Create and Assign Material
	Assign Materials
	Ambient Occlusion
	Checking AO
	Calculating AO

	How to: Calculate Ambient Occlusion

	Objective: Learn how to apply an HDR image and set it as a background environment
	Environments
	How to: Create a new environment with a new HDR image
	How to: Calculate the Ambient Occlusion for the new shadow plane

	Objective: Learn how to work with render setting options in OpenGL rendering method and create an image
	Rendering
	Render Settings
	File Output tab
	General Settings tab
	Antialiasing

	Raytracing Quality tab

	How to: Create a Rendered Image in OpenGL

	Additional Information
	Illumination modes in Raytracing
	Downscale

	How to: Create a Rendered Image of a Region in Raytracing


